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Introduction to This Guide 
Welcome to the Gatekeeper Agronomist software system from Farmplan Computer 

Systems.  

 

This guide is intended as a quick start-up guide to Gatekeeper for new users, who are either: 

starting from scratch, converting data from MultiCrop Agronomist version 3 or importing 

client’s MultiCrop or Gatekeeper data. 

 

The guide is split into two parts. Part 1 covers Gatekeeper installation, setting up new client 

businesses, converting existing data and an overview of Gatekeeper’s layout and screen 

conventions. Part 2 deals with the program modules and the different tasks which can be 

carried out within Gatekeeper Agronomist. 

 

This is a quick start-up guide and is designed to be used in conjunction with the detailed 

embedded help which can be accessed by clicking the on-screen Help icon (see below) 

which appears on every screen within Gatekeeper. 

 

The icon with the question mark takes you to the embedded detailed help.  You can 

also ring the Gatekeeper support line if required – 01594 545040. 

 

NB: Within the guide, any words in bold type indicate a button to be pressed and ► indicates 

the next step in a process. 
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Part I 
Installation 
 

Gatekeeper will take about 30 minutes to install, depending on the speed of your machine. 

Before you begin, please make sure that you have an internet connection (this will be used 

to check and register your authorisation, download updates and synchronise your 

databases), and the access code, which is provided with the installation CD.  

Note: Gatekeeper uses components of the Microsoft operating system framework. 

Therefore it is essential that all Microsoft components are updated with the most current 

versions before installing Gatekeeper. If your PC is configured to accept automatic 

updates from Microsoft it is likely to be up to date. If you are in doubt, please consult your 

system administrator or call the Gatekeeper Helpdesk.  

 

1. Windows Vista, Windows 7 and Windows 10 - Put the most recent Gatekeeper CD 
into your machine’s CD drive, it should autorun. If it doesn’t, then you will need to 
click Start (bottom left of screen), and then in the ‘search programs and files’ box at 
the bottom of the start menu, type run. Under programs at the top of the start menu 
the run application will appear, click Run to open.  
In the Open box, type D:\GK Setup.exe (D: represents your CD drive). Then click OK. 

Windows 8 (8 RT is not supported) – Put the most recent Gatekeeper CD into your 

machine’s CD drive, it should autorun. If it doesn’t, then you will need to open the 

Charm Bar by moving the pointer to the top right of the screen. Click the Search icon, 

(the top most of the Charm Bar icons), type run and press Enter. The run application 

will then appear.  

In the Open box, type D:\GK Setup.exe (D: represents your CD drive) then click OK. 

2. Before the Gatekeeper software is installed, one or more other components will 
need to be automatically installed on your machine, so click Next at the ‘Gatekeeper 
Installer’ window. These components may take a while to install so it would be worth 
familiarising yourself with some of the conventions used within Gatekeeper while 
they load (see page 8). 

 

3. When Gatekeeper is ready to be installed, click Next and you will be taken to the 
‘Gatekeeper License Agreement’ window.  Select the radial button accepting the 
terms and click Next. 
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4. Now three options will appear Typical, Custom and Complete. Chose Typical for the 
Standalone Edition (recommended for most users); Custom for Network Edition 
(Server and Client) or Standalone with specified location (Advanced) or Complete for 
all available versions (subject to licensing), this will require the most disk space.   

 

5. In the next screens you just need to click Install so that Gatekeeper will be installed 
into a Reed Business Information folder on your hard drive.  

 

6. After Gatekeeper has been installed, click on Finish.  There will now be a Gatekeeper 
icon on your desktop.  

7. Double click on  to open the program and start the registration process. 
 

A login window will appear asking you to enter the following details:  

User Name: it’s best to use your name as this name will be used throughout the 

program and will be printed on reports and work plans (don’t use a nickname if you 

don’t want it to be made public!) 

Password: this is optional, but if you do enter a password make sure you don’t forget 

it; you will need it every time you open Gatekeeper. The password is case sensitive. 

Access Code: this code is provided by Farmplan, along with the CD.  

Click Log On. 

 

8. The ‘Synchronisation’ window will appear. You just need to click Synchronise. The 
software will now use your internet connection to check your registration details, 
authorise your copy of Gatekeeper and download any updates to the program or 
Sentinel data (see page 75). 

 

9. When Gatekeeper has finished synchronising, click Close. At the ‘Add Business’ 
window, you may have several choices: ‘Add a new business’, ‘Import a business 
from MultiCrop’ or ‘Import a business from Amais’ for example. 

 

Before walking you through these options it’s best to introduce you to the basic format of 

the setup process in Gatekeeper, because at some stage everyone using the program will 

need to setup new details, such as products, split fields, etc.  

 



 
 
 

 
  8 

 

Basic Conventions within Gatekeeper 
 

The look and feel of Gatekeeper is consistent throughout, making it easy to find your way 

about. Below are some examples of the formats used within Gatekeeper, with an 

explanation of how they work. 

 

This screen shot is taken from the ‘Setup Crops and 

Varieties’ window. As you can see on the left hand 

side there is a ‘tree view’, which gives you an 

overview of the categories and headings within your 

Gatekeeper program (these will either be pre-loaded 

or you will have created them from scratch). If you 

want to see what is included under each category or 

heading you need to either click  next to the item 

or double click on the item to expand the list; to close the list click . 

 

By working through the tree view, you can click on the item you want to work with and it 

will be highlighted in blue. Once an item is highlighted, any details associated with the item 

are displayed on the right. In the above window, you can see ‘Grass Seed Crop’ ready for 

editing. 

 

In the bottom right corner you have the Gatekeeper Help options, which can be found 

throughout Gatekeeper. Just click on them to access help. 

Also at the bottom are these buttons, which govern how your work is saved throughout the 

program:  

 

 

When you click OK, any changes that you have made will be saved and the form closed. 

When you click Save any changes made will be saved and the form will remain open. When 

clicking Cancel a warning sign will appear – use this option with caution as you will lose any 

changes since you last clicked Save or OK. 
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This screen shot shows a ‘Selector’ 

window, which is found throughout 

Gatekeeper. To select items, you need to 

highlight a choice(s) in the tree view and 

use the blue arrows to transfer them to 

the selection box on the right. One arrow 

in either direction transfers the 

highlighted item(s), and the double 

arrows in either direction transfer all the 

items whether highlighted or not. 
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Setting up Client’s Data within Gatekeeper 
 

There are four ways of creating client businesses within Gatekeeper: 

 Creating a new client business from scratch. 

 Importing data from your MultiCrop Agronomist program. 

 Importing data from a client’s MultiCrop program. 

 Importing data from a client’s Gatekeeper program. 

Setting up from Scratch 

1. Choose Add a new business in the ‘Add Business’ window (if this is not on the 
screen, click the Business/Year selector in the top right hand corner of the main 
Gatekeeper screen ► Add New Main Business). Click OK.  

 

2. Within the ‘Setup Businesses’ window, your client’s business name will be set by 
default to ‘new’. To replace this, click in the Name box and replace ‘new’ with your 
client’s business name. 

 

3. If you are intending to email recommendations to this client, then you will need to 
click Setup Contacts ► Add. Fill in the Contact name box, their address details and, 
within the ‘Details’ tab, their email address (this is essential). You will also need to 
create a publishing key for this client if they are using Gatekeeper (see page 45) 
within the Publishing module section for instructions). Click OK. 

 

4. Returning to the ‘Setup Businesses’ window, click OK. 
 

 

5. The business name will now appear in the ‘Setup Business Wizard’ at the top of the 
tree view on the left (see above). Under this name are the setup headings that are 
available in Gatekeeper – you need to input your client’s business details into these 
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headings. To move though the headings you can either select them from the tree 
view or click Next or Previous. 

 

To begin with, it will only be necessary to concentrate on the following headings: 

 

Crops and Varieties: Set up Crops and Varieties in your catalogue first (see page 22). To 

import the catalogue lists into the client business go to the Setup menu>Crops and 

Varieties. From this window click Import Site List or Import Organisation List to populate 

the client business with the crops/varieties that exist within your Site or Organisation 

catalogue.  

 

N.B: For a full explanation of the catalogues held within Gatekeeper, please see the 

Catalogue Module section. If you don’t have access to an Organisation list of crops/varieties, 

and have not yet set up a Site list of crops/varieties you will need to set up a Site list within 

the Catalogue Module before continuing (see page 22). When you wish to return to the 

‘Setup Business Wizard’, click on the Business/Year selector in the main Gatekeeper 

window, and click Setup Business Wizard. 

 

Field Cropping: This section allows you to setup your clients’ fields and allocate their 

cropping (assuming that you are not importing their field records either from Gatekeeper, 

MultiCrop or a compatible third party software). For more details, see ‘Setting up and 

Amending Fields and Cropping’ in the Fields Module section (page 55). If you are going to 

exchange data with your client, it is essential that the field names and the working areas of 

each field are identical in both your and your clients programs. 

 

1. When you have either completed 
the setup, or finished part of your 
setup you will see the ‘Main 
Business and Year Selector’ window 
(see below). As you build 
Gatekeeper records you will be 
able to view different years from 
here by highlighting the year you 
want in the tree view (you will also 
use this form to move between 
clients). Make your selection and click OK, to go to the main Gatekeeper screen.  
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Setting up by importing from MultiCrop Agronomist data 

(MultiCrop Agronomist must be on the same computer as Gatekeeper Agronomist – if this 

isn’t the case, please call the support helpline - 01594 545040 

  

Before importing any data: If you are converting MultiCrop Agronomist version 3 data it’s 

important to check that your MultiCrop business years are linked correctly with the STAN 

years, and that your crops/varieties are also correctly linked, otherwise your data will be 

converted incorrectly. To do this: open up MultiCrop ► Update Summary (the Σ module 

button) ► Reports ► MultiCrop. This will give you the ‘STAN Data Audit’ report. If there are 

any discrepancies in the years or crops/varieties, then please ring the support helpline for 

assistance - 01594 545040. 

 

2. Choose Import a business from MultiCrop Version 3 in the ‘Add Business’ window (if 
this is not on the screen, click Business/Year selector in the top right hand corner of 
the main Gatekeeper screen ► Add Business). Click OK. 

 

3. The ‘Import MultiCrop v3 data’ window will appear, listing the MultiCrop stock 
centres (clients) which are held on your computer (default is within C:\ drive). 
Highlight the client you want to import and then select the ‘Import Options’ tab (see 
below). 

  

4. There are several points to be noted on the 
‘Import Options’ tab:  

 

a) You can choose how much MultiCrop 
data you import by selecting the years of 
detailed data and years of cropping that 
you require (top right). It’s automatically 
set to convert the current year and two 
previous years of detailed data and 
cropping, but if you want to select more past cropping, for example, then you 
can. Detailed data includes all of the recommendations, imported operations 
and soil analysis etc. whereas, Cropping/Soil data only includes the crop/variety 
and the soil sample history. This gives you the flexibility to bring forward a few 
recent full years but retain the whole crop and sample history.  

 

b) Next you need to decide how much of your Agronomist data (recommendations 
and field data) to import into Gatekeeper. Choose the best option from the 
‘Agronomist Options’ at the bottom of the box. Click Import and your client’s 
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MultiCrop data will be converted and imported into Gatekeeper, along with your 
recommendations.  

 

I. Import agronomist data, cropping and field notes – brings in agronomist 
recommendations, field cropping, and notes. 

II. As 1 plus sampling, agronomy and PDM notes all in as agronomist 
entered data – these data types are also brought in as though they were 
entered by the agronomist even if they were imported from customers. 

III. Import agronomist data and full field records – brings all data across 
including imported customer records. If you choose this option you 
should probably elect to exclude the pesticide type field records as they 
are likely to have corresponding recommendations giving duplicate 
records 

 

c) Then you need to import your MultiCrop Foundation data (if you had this option) 
and your Fieldsman Templates. In turn, click Import Foundation Data (only available 
if you had the foundation module) and when this is complete, click Import Fieldsman 
Templates. You only need to import these ONCE; do NOT do this step for each 
client. Check through these lists to make sure that all the data converted correctly. 

 

N.B: If you have an Organisation catalogue in Gatekeeper and you are the Catalogue 

Manager, the Foundation data will be imported to the Organisation catalogue (see page 22 

for more on catalogues). If you do not have an Organisation catalogue in Gatekeeper, the 

Foundation data will be imported into your Site catalogue assuming that YOU managed the 

MultiCrop Foundation Data. 

 

If you did not manage the MultiCrop Foundation Data, the conversion of this data will be 

completed by another member of your organisation and sent to your Organisation 

catalogue during synchronisation. Fieldsman Templates are imported to the Site catalogue, 

becoming Site Templates.  

 

5. Once happy that the client’s business details have also been imported successfully – 
check the field details in the Fields Module (page 54) and the recommendations in 
the Recommendations Module (page 29) – you should synchronise or backup your 
data (page 73) before you import another client business.  

Setting up by importing from client’s MultiCrop data 

Before importing any data: Please ask your client to check that their MultiCrop business 

years are linked correctly with the STAN years, and that their crops/varieties are also 

correctly linked, otherwise the data will be converted incorrectly. 
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To do this: open up MultiCrop ► Update Summary (the Σ module button) ► Reports ► 

MultiCrop. This will give them the ‘STAN Data Audit’ report. If there are any discrepancies in 

the years or crops/varieties, then please ask them to ring support for assistance. 

 

1. Choose Add a new business in the ‘Add Business’ window (if this is not on the 
screen, click on the Business/Year selector in the top right hand corner of the main 
Gatekeeper screen ► Add Business). Click OK. 

 

2. Within the ‘Setup Businesses’ window, your client’s business name will be set by 
default to ‘new’. To replace this, click in the Name box and replace ‘new’ with your 
client’s business name. It is helpful, but not essential, to have the same business 
name that the client uses. 

 

3. If you are intending to email recommendations to this client, then you will need to 
click Setup Contacts ► Add. Fill in the Contact name box, their address details and, 
within the ‘Details’ tab, and their email address (this is essential). You may wish to 
add their publishing key as well if you intend to publish recommendations to them 
(see page 46). Click OK. 

 

4. Returning to the ‘Setup Businesses’ window, click OK. 
 

5. Click Close at the ‘Setup Business Wizard’ window to return you to the ‘Main 
Business and Year Selector’ window.  

 

6. Ask your client to export their MultiCrop data: Field Records ► Actions ► Data 
Export ► Choose ‘Gatekeeper Agronomist’ export format ► Choose the appropriate 
export options ► Export. This should be either emailed to you or transferred to a 
USB memory stick. 

 

7. To import this data into Gatekeeper: make sure you are in the correct client business 
within the ‘Main Business and Year Selector’ window, click OK ►Go to the 

Publishing module  ► Third Party tab ►Import Field Data ► Browse to and 

select the exported .zip file using the picker button . Ensure the File Format is set 
to MultiCrop Plan File and click Import ► At the ‘Import  
 

Published Data’ window make sure that you are importing this data into the correct 

client’s business then select the option to ‘Full import of ALL field data’ ► Import 

Data. Within the 'Match Publication Fields Pre Importing' window, ensure the 



 
 
 

 
  15 

 

matching results says 'Add a brand new field' as shown in the image on the right and 

click Import. 

 

 

8. Once you are happy that the client’s business details have also been imported 
successfully – check the field details in the Fields Module (see page 54) – you should 
synchronise to make a secure backup of your data (Data Secure option required) (see 
page 73). 
 

Setting up by importing from Client’s Gatekeeper data  

 

1. Choose Add a new business in the ‘Add Business’ window (if this is not on the 
screen, click on the Business/Year selector in the top right hand corner of the main 
Gatekeeper screen ► Add Business). Click OK. 

 

2. Within the ‘Setup Businesses’ window, your client’s business name will be set by 
default to ‘new’. To replace this, click in the Name box and replace ‘new’ with your 
client’s business name. It is helpful, but not essential, to have the same business 
name that the client uses. 

 

3. Returning to the ‘Setup Businesses’ window, click OK. 
 

4. Click Close at the ‘Setup Business Wizard’ window to return you to the ‘Main 
Business and Year Selector’ window.  

 

5. You now need to exchange Publishing Keys with your client (see Publishing Module 
page 45).  

 

6. Having created, exchanged and saved the appropriate Publishing Keys, ask your 

client to publish their cropping to you: Publishing module  ► within the ‘Outbox’ 
tab, click Publish Field Records ► Select you as the contact using the selector button 

► Choose the appropriate field groups ►OK. 
 

7. The client should then synchronise OR choose to ‘Distribute Locally’ to copy the file 
to a USB memory stick. 

 

8. On your computer, choose the client in the ‘Business and Year Selector’ window.  
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9. Either: 
a) Synchronise (if the client sent the data by synchronisation) and then go to the 

Publishing module ► Within the ‘Inbox’ tab, highlight the published data in the 
grid and click Import Published Data ► In the ‘Import Published Data’ window 
make sure that you are importing this data into the correct business, then select 
the option to ‘Full import of ALL field data’ and click Import Data. Within the 
'Match Publication Fields Pre Importing' window,  ensure the matching results 
says 'Add a brand new field' and 'Add a new cropping record '.Click Import. 

Or: 

b) If the client transferred the data via USB memory stick, go to the Publishing 
module in the appropriate business ► Within the ‘Inbox’ tab, click Fetch Local 
Publication ► Point to the file and click Open ► At the ‘Import Published Data’ 
window, make sure that you are importing this data into the correct business 
then select the option to ‘Full import of ALL field data’ and click Import Data. 
Within the 'Match Publication Fields Pre Importing' window,  ensure the 
matching results says 'Add a brand new field' and 'Add a new cropping record ' 
click import. 

10. Once you are happy that the client’s business details have also been imported 
successfully – check the field details in the Fields Module (page 53) – you should 
synchronise or backup your data (page 73). 
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Gatekeeper Layout and Screen Conventions 
Once you have your client’s data within Gatekeeper you can begin to use the program. You 

should acquaint yourself with the main Gatekeeper layout, the screen conventions and an 

overview of the Modules within Gatekeeper first.  

 

Below are the names that have been given to various parts of the main screen – they will be 

used throughout this guide. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Top Menus    

 

File: -   Log Off and Exit the program. 

Setup:  -  Setup any new items here. 

Tools:  -  The User Manager allows you to dictate who can use the program and what 

areas they are allowed to see/work in.  

Options determine the way certain settings and functions are used for your 

business. It is also used for the customisation of Gatekeeper; such as report 

headers and colours etc. 

Help:  -   Access Help menus and Support information. 

Top Menus 

Module Buttons    Tree view Filter Buttons   Grid Tabs 

Module Options 

Tree View       Grid Footer Status Bar       Main Grid 

Business/Year       
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The Module Buttons and Module Options  

 

 

Orders: allows you to create, view and edit product orders based on 

recommendations.  

 

Fields: browse records for individual fields, including field operations, soil sampling 

and buffer zone information, and setup fields and cropping. 

 

Recording: Use to record field records not entered though the Recommendations 

Module. 

 

Recommendations: allows you to generate recommendations for jobs that need to 

be done on clients’ farms; verified by Sentinel Active.  

 

Catalogues: you can view, organise and manage the products and crops/varieties 

used by your clients (and view those products within Sentinel). 

 

Publishing: the place where incoming messages and data are received after 

synchronisation, and where messages and data to be sent are stored before 

synchronisation. 

 

Devices: this module enables the exchange of data between Gatekeeper and in-cab 

controllers, handheld devices and other external software sources.  

 

Analysis: allows you to create personalised reports across and/or within your client 

farm businesses. 

  

Agrilator: contains a collection of calculators and conversion tools for units of 

measurement and others specific to agriculture. 

 



 
 
 

 
  19 

 

Sentinel: provides a wide range of agronomic, business and environmental 

information. Sentinel Active users will also receive detailed crop approval 

information for all UK pesticides. 

 

Synchronisation: allows you to backup data, download program updates and 

Sentinel data, and send and receive publications. 

 

Business:  use to see and manage the business structure all in one place. Holds and 

records weather information and business Notes.  Cropping years can also be 

managed within this module.  

The Tree View, Filter Buttons and Search 

How to navigate through the tree 

view has already been covered 

on page 8. The details that 

appear in the tree view can be 

sorted under different headings 

using the Filter Buttons. For 

example, the Fields Module tree 

view can be arranged by: 

Holding, Field Group, Crop, 

Variety, and Tag The search 

facility (the blank box above the 

tree view and below the filter 

buttons) allows you to find 

specific fields by typing the first 

few letters of the field name.  

 

Status Bar 

This ‘clickable’ bar allows you to: view the logged in user/s, toggle between hectares or 

acres and working area or official area, and shows warning indicators -  indicates a 

warning; click on the sign to get an explanation. The currency in use is also displayed on this 

bar. 
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The Main Grid, Grid Footer and Grid Tabs 

The Main Grid displays the details associated with the item highlighted in blue in the tree 

view. You can click on the Grid Tabs to view different aspects of data associated with the 

item. 
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Part 2 

 

Catalogues Module 
 
The catalogues within Gatekeeper Agronomist hold the information that might be shared 

across client businesses or even amongst a team of agronomists working collaboratively. 

Information contained in the catalogues can be used to create recommendations and setup 

client fields, such as crops/varieties, products, templates and comments. There are three 

potential catalogue types:  

 

 Organisation catalogue (optional) – users can elect to have this optional facility 
within Gatekeeper if they are part of an organisation with multiple sites. There is one 
designated catalogue manager who has full editing rights and other users are only 
able to view, and choose items from the catalogue. This catalogue is distributed and 
updated automatically during synchronisation and this allows for consistency in 
choice of products (including pricing), crops/varieties, user-defined reports, 
templates, comments and checks/protocols etc. across all sites in the same 
Organisation. 

 

 Site catalogue – every Gatekeeper user has this catalogue. It enables you to set up 
your own templates, comments, products and crops/varieties to use across multiple 
client businesses on your Gatekeeper Site. You manage your Site catalogue 
independently of the Organisation catalogue but it has the facility to store similar 
data types (see below).  

 

 Sentinel catalogue  – this catalogue carries all UK approved pesticide information, 
such as pesticide name, LERAP details, active ingredient(s), SOLA's and MAPP ID 
numbers. When a pesticide is added to a business stock list, or to a Site or 
Organisation catalogue, it is usually picked from the Sentinel catalogue and linked 
accordingly, thus carrying the actives and other pesticide data which it will verify 
against assuming that you have purchased the optional Sentinel Active version. 

 

Setting up a Site Catalogue 

You will certainly need to set up your Site catalogue if you don’t have access to an 

Organisation catalogue – to include all crops and varieties, products to recommend, 

comments and recommendation templates you will use, which can be accessed by, and 

applied to any client business. However, if you ARE part of an organisation which has 

purchased the optional Organisation catalogue facility, you can add items to your Site 
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catalogue that you need in addition to those in the Organisation catalogue (for example 

your own templates, comments and perhaps the odd product).  

 

To setup Crops and Varieties in a Site or Organisation catalogue:  

In the main Catalogue Module window select the appropriate catalogue fitter button 

(‘Organisation’ will be only be visible if you have the facility) and click the Crops and 

Varieties button. 

 

 

 

1. The ‘Setup Crops and Varieties list for – Site Catalogue’ window appears. Within 
Gatekeeper, crops and varieties are organised into three tiers: Crop Groups (e.g. 
Wheat Winter), Crops (e.g. Feed Wheat, Milling Wheat), and Varieties (e.g. Chianti, 
Arran). Choose a Crop Group via Activate Crop Group, e.g. Wheat Winter, from the 
pre-defined list. A linked Crop will be created automatically; in this case, Wheat 
Winter. If you want to have your own Crop(s), e.g. Wheat Feed or Wheat Milling, etc, 
you can add these via Add Crop to Group. By clicking on the Crop in the tree view, 
you can then add varieties to each Crop via Add Variety to Crop.  

 

2. Click Save and repeat the process until you have finished inputting information. If 
you don’t want to use the Crop name created by default when you activated the 
Crop Group, simply click the Crop name and make it Inactive. 

To setup Products in the Site or Organisation catalogue 

1. Choose the appropriate catalogue filter button  (‘Organisation’ will be only be visible 
if you have the facility) in the main Catalogue Module window, and click Add 
Product. 

 

2. In the ‘Add new product to Catalogue’ window, choose ‘Sentinel Catalogue’  
(assuming that you are adding pesticide type products) from the ‘Source’ drop-down 
list and the tree view will populate with products held in Sentinel. 

 

3. Select any number of products you wish to use across your businesses from this list. 
You can type into the empty white text box to search for specific products. A ‘Unit 
Group’ is assigned automatically to each selected product. Click OK. 
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4. In the ‘Site Catalogue Product Details’ window, choose a ‘display unit’ as appropriate 
and a default application rate for the product (per hectare). If you wish to add pack 
sizes and prices to products, use the ‘Catalogue Prices’ tab (right bottom) and setup 
prices by setting up a company the product will be sourced from if applicable  (Setup 

Companies button) and using the  button (see the Orders Module for more 
information on Companies, page 37).You can add comments and other details using 
the tabs available. Note: if you picked the product from the Sentinel catalogue you 
only need to check the display units are Ok and add a product comment if you wish. 
The remaining data will be accessed from Sentinel.  

 
5. Click Add Product (top right) to add additional products to your Site catalogue. Click 

OK to return to the main Catalogue Module window. 
 

N.B: If you wish to add non-pesticide 

products to your Site catalogue, such 

as adjuvants or fertilisers, click on 

Custom (see right) in the ‘Add new 

product to Site Catalogue’ window. 

You can then enter the product 

details manually. If you are entering a 

fertiliser, place it under the correct 

‘Heading group’ and, in the ‘Site 

Catalogue Product Details’ window, 

use the ‘Analysis’ tab (see over) to 
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create a nutrient analysis (click  to select  

 

Once products are entered into the Site catalogue they are stored in the main tree view 

alphabetically under their Heading.  

 

To edit any product details (including product prices), select the product from the tree view 

and click on the Edit Product option button at the top of the page. Alternatively, select the 

product heading in the tree view and click on Edit Products to edit several products. Edit 

product prices by clicking on the Catalogue Prices tab ► double click on the product price in 

the grid ► changing the unit/pack price ► OK. 
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Catalogue product prices and 
pricing logic in recommendations 
and Orders: 
When you add a new client business, you 

can nominate a Fixed company for orders 

and catalogue prices. If you do so, it 

means that the nominated companies 

prices will be used in the 

recommendations and the nominated 

company will always be used by default to 

fulfil Orders for that particular client. You 

can nominate different companies for 

particular client businesses.  

If you do not nominate a fixed company, 

then in the recommendation, Gatekeeper 

will use the lowest price that it can find in the nominated catalogue for that product 

regardless of supplier.  

 
 

NB: You can amend the price in the recommendation to any price that you care to enter in 

that recommendation job, in which case the price entered “on the fly” in the Job will be held 

for that job only.  

If you make a Plan based Order (see Orders page 50) the price in the order will be based on 

the options that you choose when building the order.   

 

To update prices in existing recommendations with changed Catalogue prices 

You can amend catalogue prices at any time and from that point on the new prices will be 

reflected in new Jobs and Orders. However, if you wish the new Catalogue prices to be 

reflected in recommendations already created, you will need to use the Update Prices 

function in Catalogues. First edit the catalogue prices for products that you wish to change. 

Then in the Catalogue Module main window use the ‘Update Prices’ option button in the 

main window ► select the Harvest year, Plan Issue Dates and the Businesses that are to be 

updated ► Update Prices ► OK. (See below) 
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To setup Recommendation Comments in a catalogue 

When you are building Recommendations, Orders and setting up products, Gatekeeper 

often provides the facility to add comments. Although you can type any comment “on the 

fly”, you may want to have a list of standard comments that you can re-use simply by 

picking them from the list. The advantage of having standard comments is that you only 

have to set them up once in the appropriate comments list from which you can pick them 

when you need them.  

 

These text insertions or ‘Comments’ can either be setup within the ‘Setup’ Menu at the top 

of the main window, or (as we recommend) when you are working within a module and 

need to create a comment (e.g. when 

creating a recommendation) – this way it 

will be created within context 

(in other words, you will see the 

context in which the comment is being 

used and find it easier to see what 

comments would be appropriate in that 

list). To create and select comments you 

need to open the ‘Comment Selector’ 

window that is accessed using the selector  
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button, which is found anywhere where a comment can be inserted.  

 

1. To create a comment for a product within the Catalogue module, click on Edit 
Product ► Product Comment tab ► Selector Button  

2. Highlight the heading under which you wish to add a comment (e.g. Justifications) 
and click Add Comment. 

3. N.B: The default comment heading for the section you are in will be automatically 
opened and that is where you would normally add comments. 

4. Within the ‘Setup Comments’ window, make sure you are in the Site catalogue and 
overtype ‘New’ with your comment. Click Save. 

5. If you wish to add more comments, highlight a heading and click Add.  
 

Any comments you have created will be part of the Site catalogue and will be available 

across all businesses, via the ‘Comment Selector’ window (see previous page). You can 

insert multiple comments (Click Add After to add first comment) from these lists into 

appropriate areas, using comment separators, which means that you don’t have to setup 

individual, long-winded comments. If you are the Organisational catalogue manager, you 

will be able to create and edit comments from here too, or in the Setup (Top Menu). 
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Recommendations Module  
 
This module allows you to create and issue recommendations. A recommendation 

represents a round of spraying, drilling, fertilising or other field based activity for which you 

want to advise your client on what to do, where and when. A recommendation consists of 

one or more Jobs and a Job consists of one or more fields which will be treated with the 

same product/s at the same rate/s. Thus the Job carries a list of the target fields, target 

products and rates, together with any comments and advice notes, warnings etc that are 

needed to ensure that your client carries out the work you intended. 

 

If you have the optional SentinelActive module, your recommendation will be verified 

against UK crop approvals for pesticide type products and you will be alerted if Sentinel can 

spot any potential issues with your recommendation. Of course the final responsibility lies 

with you to ensure that your proposed application is appropriate. 

 

Having created the recommendation, you can print it out and pass it to your client, or you 

can transfer the recommendation electronically. 

 

Recommendations can be started from scratch or can be based on templates (see page 26), 

which are created within this module. A Template is a recommendation Job which once 

setup can be copied and used on any client. It makes sense to setup Template Jobs for 

applications which you will be using time and again so that you don’t have to repeat the 

same thing for every customer. You can base a job on a template job and then “tweak” it for 

each client’s particular circumstances.  

 

Creating a New Recommendation from Scratch 

In the Recommendations Module, make sure you are in the correct client Business and click 

Add Plan (first module option). 

  

From within the ‘Recommendations Setup’ window, there are several options: First give the 

plan a name next to the Reference which is recognisable for both you and the client. The 

Plan will automatically be allocated the next available sequential plan number. The ‘Contact’ 

is the client and will be automatically populated assuming you have set up the contact (see 

pages 10 and 45)  and elected that contact to be used by default for Recommendations. You 

can set your preferences for verification and LERAPs management which will be 

remembered for the next plan.  Plan Comments and Conditions can be added by free typing 

or using the button (see page 21 for more details about setting up comments). 
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Click Add Job >> (top right). Choose the Job Type from the drop-down list  and choose 

‘Adding a new job’. Click Add Field Operations Job (or whichever job type you chose. See 

Recommendation Job types on next page for further information). Remember that a ‘job’ is 

defined as a field, or a group of fields, which are going to be treated with the same 

product(s) at the same rate(s), although you can use the Split Job option if you wish to use 

different rates (see page 51). 
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Recommendation Job types are: 

 Field Operations – This is the Job type that you will use most often. You can include 
all recommendation details including implement settings. 

 Field Operations Products Only – Similar to Field Operations Job type except you 
can’t include implement settings. 

 Field Sampling – Use to add soil sampling records to fields. 

 Field Nutrients – Use to add a recommendation specifying the quantity of fertiliser 
NUTRIENT (as opposed to quantity of fertiliser product) to fields. A field Nutrients 
type Job can be converted into a product based job (see page 46) 

 Field Diary Notes – Use to add notes type jobs i.e. no products to apply. 
 

1. Choose the field(s) you are planning to work on in the ‘Field Selector’ window. 
Remember that you can filter the field list by crop, variety, field group, etc. Click OK.  

 

2. In the ‘Product Selector’ window, choose from the Organisation or Site catalogue 
from the Source drop down list and select the products(s) you are planning to use 
and adjust the rate(s) as required. Remember that you can filter the product list by 
heading, heading type, etc. Click OK.  
Once you have selected the source catalogue Gatekeeper will offer you the same 

catalogue next time as you will nearly always use the same catalogue to pick 

products from. Note: The products will be priced in the recommendation at the 

lowest price available in the source catalogue across all catalogue supplier 

companies. However, if you have elected a Fixed company for orders and catalogue 

prices (see page 19) then the lowest price from that company will be used. You can 

change the price in the recommendation in which case that price will be held in that 

job for that product. If the same product is used in other jobs in the same 

recommendation, the price of the product when picked will be the default price and 

will need to be changed as necessary.  

 

3. Within the ‘Recommendations Setup’ window (see below) you will see the results of 
the Sentinel 
verification (if you 
turned it on) next to 
the product(s) being 
used – a green tick 
indicates that 
verification has not 
identified any issues, 
an amber 
exclamation mark is 
a warning, but a red 
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cross is a failure. To find out the reasons for a warning or a failure, click Verification 
Results (middle bottom).  

 

4. If you wish to treat some fields differently (e.g. different product rate(s), you can use 
the Split Job button (see page 51), which allows you to break an existing job into 
separate jobs. This provides a great deal of flexibility within the module. 

 

5. Under the ‘Job Header’ tab (bottom middle) within the same window (see above), 
you can add Job Reasons and Job Comments; within the ‘Product’ tab you can add 
Reasons and Justifications for using the products and within the ‘Note’ tab you can 
add Note Comments. 

 

6. Also within the ‘Recommendations Setup’ window is the ‘Implement’ tab (middle 
bottom), click on this to fill in information, such as tank mix volume rate and LERAP 
star rating. You can also add Application Comments. Note: these are the settings 
details for your client to use to configure their application equipment. There is no 
provision for you to add a machine with settings specific to each client. 

 

7. Carry on adding as many jobs to the recommendation as you wish using Add Job >>. 
When you are happy with your recommendation, click OK. You will be taken back to 
the main Recommendations window and your plan will appear in the tree view 
under ‘Draft’. If you have more than one recommendation in the tree view you can 
move between them by highlighting the recommendation you want to work with.  

 

You can edit recommendations at any time; just select the appropriate plan in the main tree 

view and click Edit Plan (second module option). 

 

Issuing and Publishing a Recommendation 

Before a recommendation can be printed out, transferred to a device or published to a 

client, it has to be issued. Once a Recommendation is issued it will be taken into account 

when verifying future Jobs. Only users with the necessary permissions can Issue 

recommendations. The permission to issue Recommendations is set on by default. Once 

Issued, the details of the recommendation will be shown against each field included in the 

recommendation, in the Fields module with a small icon against each line indicating an 

issued (as opposed to completed or customer imported status). 

 

To issue a recommendation:  

1. Highlight the plan in the main tree view and click Issue Plan (third module option). 
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2. Check the details in the ‘Issue and Publish Plan’ window are correct and click Issue 
Plan. 

 
 

1. The plan status will then change from ‘Draft’ 
to ‘Issued’ and you have several options 
open to you depending on whether your 
client has MultiCrop or Gatekeeper . 

 

a) If transferring recommendations to non-
Gatekeeper users: Plan Reports ► 
Recommendation Plan (Fields First) ► Run 
Report. The report can then be printed out 
and posted, faxed or given by hand. It can 
also be emailed as a PDF, using the button in 
the report window. Select the contact in the 
‘Add New Publication’ window (the 
contact’s email must already be set up – see step 3, page 10) and click OK. After 
synchronising, the email with a PDF attached will be sent via the Gatekeeper email 
server.  

 

b) If transferring recommendations to MultiCrop or Third Party users: use the same 
method as in a), but tick the ‘Include MultiCrop format data file’ OR ‘Third Party GK 
XML data file’ box before clicking OK in the ‘Add New Publication’ window. After 
synchronising, the email, with a PDF and MultiCrop/XML  import file attached, will be 
sent via the Gatekeeper email server.  

 

c) If publishing recommendations to Gatekeeper users: follow the same method in a) to 
run the report and check the details, then close the report and the ‘Select Report’ 
window. In the ‘Issue and Publish Plan’ window, click Publish Gatekeeper Plan and 
choose your contact in the ‘Add New Publication’ window (you need to have already 
exchanged Publishing Keys – (see page 45). Click OK and the recommendation will 
remain in the Publishing Outbox  until you synchronise, when it will be published to 
the Gatekeeper server until the client synchronises and the recommendation is 
transferred to their Publishing Inbox.  
 

NB: If a product order has been generated from the recommendation, the 'Also publish 

linked order' option can be ticked to include the order as part of the publication.   

 

Recommendation Reports 

There are various recommendation report options and formats. In all cases, first create your 

recommendation and then Issue it. You can generate recommendation reports for Draft 
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status recommendations in order to preview before issuing, but they will carry a watermark 

saying Draft plan not authorised for use.  

 

To generate a recommendation report: 

1. First create and issue your recommendation which should be highlighted in the 
main Recommendations module tree view. 

 

2. Click the Reports module button. 
 

3. Choose the appropriate report and set the options for that report. For product 
based recommendations, the report is likely to be either Recommendation Plan 
(Fields First) or Recommendation Plan (Products First). The options that you select 
will be remembered for the next time that you visit this Reports section. The 
options available depend on the report selected in the side bar. 

 

4. Recommendation reports can be printed and/or emailed as PDF attachments (See 
pages 32 and 45)  

 

Templates and recommendations 

It is more than likely that you will be prescribing the same types of recommendations across 

your clients’ businesses, e.g. autumn weed control strategies. Template Plans (either 

Organisation or Site) allow you to create a number of jobs held under the same ‘theme’ to 

provide a quick way of issuing similar product recommendations without having to create 

them from scratch every time, e.g. under the template plan (or ‘theme’) of autumn weed 

control, you can have many jobs containing different cocktails of product applications (with 

suitable comments). When you use a template, you use a specific template JOB you do not 

copy the whole template plan.  
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To create a Template Plan: 

1. Remember that each Template Plan is likely to be a collection of Jobs under the 
same theme, for example Autumn weed control, or Spring wheat fungicides, etc. The 
first thing to do is to create the Plan (theme) and then create individual jobs under 
that Plan. To create a new 
Template Plan; click the 
dropdown arrow to the 

right of Add Plan    to 
bring up the ‘Add New Plan’ 
window. Choose ‘Site’ 
Template if you want to use 
the templates on any client 
business on your Site. 
Choose Organisation (only 
available if you are the 
designated Organisation 
Catalogue manager) if you 
want the templates to be 
available to any agronomist 
site within your organisation. Under “Create a new plan by” select  the “Adding a 
new plan” option and click Add Plan. 

 

2. In the Plan Reference enter the name for the template Plan “theme” e.g. Wheat 
spring fungicides and then click Add Job >>. 

 

3. Now you will create a number of Jobs, remembering that each job represents a 
cocktail of product/s including all the rate/s and comments that would be 
appropriate under this theme (in this example Wheat spring fungicides). You can add 
Jobs to this or any other Template Plan at any time by selecting the appropriate 
Template Plan from the tree view in the main Recommendations module window 
and clicking the “Edit Plan” module option button. 
 

4. Jobs can be added to a template plan either by creating from scratch or by copying 
other jobs (either template or normal recommendation Jobs). 

 

To add a template job from scratch: 

I. First add the template plan or select the appropriate template plan and click Edit 
Plan and then click Add Job >> 

 

II. In the Add New Job window Choose New Job Type of “Field Operations Products 
Only” and choose to Create a new job by “Adding a new job” and then click the 
Add Field Operations Products Only Job button. 
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III. Set up the Job in the normal way EXCEPT you won’t add any fields at this stage. 
They will be added when you use the template job on a clients business. Most 
importantly you MUST name the job which is done from the Job Header tab at 
the bottom of the recommendations setup window. Click this tab and enter a 
suitable name in the Optional Job Reference slot. It is this name that you will use 
to identify this template job from other template jobs in the same template plan. 
As a suggestion use concatenated names of the products in the job, for example,  
Amistar/Hallmrk/5C. 

IV. Remember to add any Job and product comments. It is worth taking some 
trouble over this as this detail will be included every time you use the template 
job and is a very effective way of passing useful information to your clients 
without having to type it every time. Don’t forget that you can edit any part of a 
recommendation job which is based on a template job. 

V. Click Add Job >> to continue adding further jobs or OK to save and close. 
 

To add a template job by copying a previous Job: 

I. First add the template plan or select the appropriate template plan and click Edit 
Plan and then click Add Job 
>> 

II. In the Add New Job window 
choose New Job Type  of 
“Field Operations Products 
Only” and choose to Create 
a new job by “Copying from 
the selected job/template 
job”. 

III. Now select the Job that you 
want to copy from the tree 
view. This can be either a 
template type job or a real 
recommendations type job  
and then click the Add Field 
Operations Products Only Job button. 

IV. Edit the Job details as necessary and don’t forget to name the Job (see earlier 
section) 
 

5. Once you have finished adding Jobs to the template plan, click OK and the 
recommendation will appear in the main tree view under the ‘Template’ heading. 
Remember that you can add new jobs to any existing Template by highlighting the 
appropriate template in the main module tree view and then clicking Edit Plan. It 
doesn’t matter which client business you have selected when editing Site or 
Organisation Templates as these templates are visible in all client businesses. 
However, if you want to copy a recommendation job from a particular client to a 
template Job, you will have to select that client so that those recommendations are 
available to copy. 
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Using a Template Recommendation 

You use Template Jobs to copy to recommendation jobs. You would rarely, if ever, copy a 

whole template plan to a recommendation plan. Thus a recommendation plan can consist of 

jobs, some created from scratch with others copied from one or more template jobs from 

one or more template plans. 

 

To use a template job in a recommendation:  

1. Make sure you are in the correct client business and click Add Plan.  
 

2. In the ‘Recommendations Setup’ window, name your plan and click Add Job>>. 
 

3. Choose ‘Copying from the selected job’ in the ‘Add New Job’ window and the tree 
view will populate with template recommendations. Highlight the template job you 
wish to copy from and click Copy Field Operations Job. 

 

4. Choose the fields you wish to include in the job in the ‘Field Selector’ window. Click 
OK. 

 

5. The ‘Recommendations Setup’ window will now contain your copied job, complete 
with comments, etc. You can edit any product details/comments as required and add 
further jobs to the plan. When you are happy, clicking OK will take you back to the 
main window and the recommendation will be under ‘Draft’ in the tree view.  
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Recommendation Plan Products Required 
You can easily and quickly see the total product required to complete a recommendation 

Plan without having to create a product order. This is handy if you want to get a “quick and 

dirty” view on products required.  You can see how much product is required across a 

recommendation (containing multiple jobs) by highlighting the plan in the tree view ► 

Show 

Details >> 

(bottom of 

main 

window) ► 

‘Requirements’ tab. If you need to create an order see Orders (page 37).  
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Recording Work Done 
Once you have issued a recommendation, the Work Done button appears (the second 

module option) in the main Recommendations Module window. You can use the Work Done 

function to add the application dates etc. to completed recommendations. It is not essential 

to do this, although it is a useful exercise and will allow completed nutrient 

recommendations to be taken into account when using the Nutrient Management Module.  

 

In the situation where a client records their own work done (in either MultiCrop or 

Gatekeeper) and you import their field records (see pages 13 and 15) you will be able to see 

what was actually carried out, and when. However, the original recommendation will not 

have its status of ‘Issued’ updated automatically to ‘Completed’ and thus will remain a 

record of what you issued to the customer as opposed to what they perhaps did.  

 
To record work completed: 

1. Select the recommendation you wish to work with in the tree view and click Work 
Done (making sure you are in the correct business). 

2. In the ‘Recommendations Record Work Done’ window you need to fill in the yellow 
cells based on the work done, rather than what was planned, e.g. there may have 
been delays to completing the job so the work was not done on the planned day (see 
next page).  

3. NB: If you want to record more detailed observations such as time started and 
finished for the completed work, you need to go to Tools in the Top Menus ► 
Options ► Field Jobs (in the tree view) ► tick ‘Record work done observations for 
recommendation jobs’ (optionally the tractor and implement can also be recorded 
with these setting, tick if required) ► OK ► back into Work Done ► ‘Job Header’ 
tab (middle bottom) ► ‘Observations Format’ tab (mid screen) ► tick boxes as 
required ► return to the ‘Job’ tab. 

 

4. If the job was not 
fully completed you 
can fill in some 
details and come 
back to it at a later 
date. Outstanding 
work in the 
recommendation is 
indicated in the tree 
view by blue 
question marks (see 
right) and, if the 
recommendation is closed, it will be listed under ‘Started’ in the main tree view.  
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5. Within the window, you can add a field to an existing job by using the Select Fields 
button. You can remove a field in the same way. You can also add and change 
products by using the “Select Products” button to access the product selector. 

 

 

6. If you wish to break up an existing job into separate jobs (involving one or more 
fields), use the Split Job button (see page 51). 

 

7. Once all the work is recorded in a recommendation, and saved, it is listed as 
‘Completed’ in the main tree view. 

 

Cancelling Recommendations, Jobs and Fields 
 

If whole or part recommendations are not carried out you can keep them but change their 

status to clearly indicate what has and has not been done. In this way you retain the record 

of what was advised to the client without compromising your field recommendation history 

for the purposes of verification or nutrient planning. 

 
To cancel a whole recommendation plan: In the recommendations window, select the 

Issued plan to be cancelled and click Work Done. Click the Plan tab and click Cancel Plan. 

 

To cancel a field: Open the plan as above, click the Fields tab, select the field to cancel and 
click Cancel Field. 
 

To cancel a Job: Open the plan as above, click the Job header tab, select the job to cancel 

and click Cancel Job.  

 

Creating a Nutrient Type Recommendation 
 

As mentioned earlier in this chapter, recommendation plan jobs can be of various types. 

One such type is called a Field Nutrients type job and allows you to create a 

recommendation plan based on quantity of fertiliser nutrient as opposed to quantity of 

fertiliser product. Field Nutrient plans can be converted into product based plans eventually. 
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The logical work flow for nutrient planning is to use the Nutrient Management module (UK 

only) first to help calculate the optimum quantity of nutrient required for each field and 

then build a Field Nutrients type recommendation plan and then finally convert this to a 

normal Field Operations type recommendation plan.  

  

 

 

 

 

 

 

 

 

To create a Field Nutrient job based plan: 

1. Add a new plan in the normal way and then click Add Job (Nutrient Jobs can also be 
built directly from the nutrient recommendation, see page 46 for more information). 

 

2. Under New Job Type choose Field Nutrients and click Add Field Nutrients Job. 
 

3. Select fields into the Job from the tree view and click OK. 
 

4. Now from the Sampling Heading Selector select the nutrients that you want to 
include, e.g. N and click OK. 

 

5. In the Recommendations Setup window enter the target rate against the Nutrient 
which is the total amount of Nutrient that you wish to apply. Also enter any 
comments etc that you may want if you intend to send this Nutrient 
recommendation to a client. However, if you are going to convert it in to a product 
based recommendation first then don’t bother to add comments yet. 

 

6. Either issue and report/publish OR go to next section to convert to a product based 
recommendation. 

 

Run Nutrient 

Management to calculate 

optimum requirement. 

See page 58  Create Field Nutrients 

type job 

recommendation.  

Convert Field Nutrients job 

type recommendation to Field 

Operations Job type 

recommendation. Issue and 
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To convert a Nutrient recommendation to a product based recommendation: 

1. First make the Nutrient based recommendation (see above). Have the 
recommendation open on the Nutrient job to convert. 

2. Click the Convert Nutrient Job To Products button (see below) 

 

3. Set the options in the Convert Nutrient Job To Products window (see over) 
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4. Having converted the Nutrient Job/s to Products Job/s make sure that you name 
each job and add any notes required (see below) 

 

5. You now have a nutrient recommendation with a draft status. In our example we 
created a recommendation containing a three dose N application programme. You 
could issue and send the recommendation to your client “as is” or you could decide 
to keep this recommendation as a draft version and then create a new 
Recommendation plan containing the first application Job/s only, copying them from 
the draft programme/s. That way you remain in control of the fertiliser programme 
at each stage.  

 

Recommendation product pricing 
 

Products will be priced in the recommendations at the price stored at the point of creating 

the recommendation. This will either be the catalogue price or the user defined price 

entered when making the recommendation. If no prices are setup in the Catalogue and no 

price was entered at the point of making the recommendation, then the price will be zero. 

 

Recommendation prices can be changed in one of 3 ways: 

 Edit individual recommendations – only suitable if one or two recommendations 
need changing. 
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 Edit the catalogue prices and then use the Update Prices function in Catalogues (see 
page 19-20). – useful if you want to change prices sourced from catalogues across 
one or more client businesses, but not if you want to change the recommendation 
prices for all or a range of recommendations in a single client business.  

 

 Use the Pricing function in the Recommendations Module – useful if you want to 
change the prices for several recommendations over a defined date range for a 
specific customer or if you want to price up recommendations at a later date. See 
the following notes on how to use Pricing. 

 

Changing prices using Pricing 
 

Pricing allows you to change product prices in recommendations for a specific client within a 

specified date range. To change recommendation prices using this method: 

1. Select the client using the Business and Year selector and go to the 
Recommendations Module. 

 

2. Click the module option button labelled Pricing. 
 

3. Set the options and amend the prices as required (see below). Click Save to make the 
changes.  
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Publishing Module 
 
This module allows you to send and receive data from other Gatekeeper users electronically 

(see steps 6-7, page 13) for instructions on importing field records from MultiCrop users and 

other 3rd parties), either during the synchronisation process or locally, via a memory stick. 

You will receive cropping and field records from your clients into your Inbox, and you will 

send recommendations (see previous chapter) or cropping records to your clients, which 

will sit in your Outbox until synchronisation. You may also want to send data or reports to 

different locations and businesses. 

 

NB: If you want to send out publications quickly, without having to synchronise, you can use 

the Send Now button (next to the carrier pigeon icon) in your Outbox. 

 

However, you will only be able to send data to, and receive data from, other Gatekeeper 

users with whom you have swapped Publishing Keys. This essential part of Gatekeeper 

security ensures that published data will only end up at its intended destination. The 

following instructions will take you through the process of creating a Key, and swapping this 

Key with your chosen party (known as a Business Contact), either via email or a USB 

memory stick. You only need to go through this process once with each party. 

 

Creating and Sending a Key 
 

1. If the recipient of your Key is not already set up as a ‘Business Contact’ you need to 
click on the Business/Year Selector (coloured box in the top right of the main 
Gatekeeper 
screen)  ► Setup 
Business 
Contacts ►Add. 
Fill in their name 
(and address if 
you wish), but 
the most 
important 
information to 
enter is a valid 
email address for 
them within the 
‘Details’ tab. 
Click OK.  
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2. Go to the Publishing module and click into the Outbox tab. 
 

If you wish to send the Key via email: 

1. Click Send Key and you will be prompted for a four-digit code (as shown above), 
which is the ‘unlock’ code for the Key and is needed by the recipient of your Key, so 
please make a note of it. Click OK. 

 

2. In the ‘Add New Publication’ window, choose your recipient using the picker box to 
the right and add a message if you wish – it can be the four-digit unlock code. If you 
would like to keep a copy of your sent items, use the ‘Send a copy to ‘me’’ tick box. 
This will forward you a copy of the publication to your email account. Click OK and 
the Key will be placed in your Outbox and sent the next time you synchronise. 

 

If you wish to transfer the key via memory stick: 

1. Click Save Key and within the ‘Save Gatekeeper key file’ window, browse for the 
location of your memory stick, then click Save. You will be prompted for a four-digit 
code, which is the ‘unlock’ code for the Key and is needed by the recipient of your 
Key, so please make a note of it. Click OK. Your Key is now on the memory stick. 

 

Receiving a Contact’s Key  
 

Depending on which method you chose, the Key will arrive either as an email attachment, or 

as a file on a memory stick. Follow the instructions below for the appropriate method, BUT 

if the Key came via email, you must save the attachment to a known location first (e.g. 

create a ‘Gatekeeper’ folder within ‘My Documents’ and save it to there).  

1. Click on the Business/Year Selector ► Setup Business Contacts. 
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2. Assuming that your Contact is 
already set up, select the 
appropriate Contact in the 
‘Setup Contacts’ window tree 
view and click on the ‘Details’ 
tab (see right).  

 

3. Next to the red Key icon, click 
Add and browse within the 
‘Add Gatekeeper Publishing 
Certificate’ window to find 
the Key file (ending in .gkk). Click Open. 

 

4. Enter the 4-digit code you received from your Contact when prompted, and then 
click OK. 

 

5. You will now notice that the Key icon has turned green, meaning that you can now 
publish to that Contact. 

 

6. Click Save or OK to save and close. 
 

Sending Field Cropping / Field Records 
 

Once you have set up your Contacts, if you want to send field records, as well as field 

cropping, to anyone, you will need to:  

1. Click Tools (in the Top Menus) ► Options ► General (under the ‘Business’ heading 
in the tree view) ► Tick the box ‘Allow Gatekeeper export of operations, notes and 
sampling; as well as just  

2. cropping’ ► OK. This step only needs to be done once.  
 

3. Go to the Publishing module and click on the ‘Outbox’ tab. 
 

 

4. Click Publish Field Records 
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5. In the ‘Add New Publication’ window, chose the Business Contact you are exporting 
to, your Harvest year and which Field Groups you wish to export. If you want to send 
‘Cropping operations notes and sampling’ as well, select the option. Click OK. 

 

6. The data will remain in the Outbox until you synchronise, when it will be published 
to the Gatekeeper server until the recipient synchronises at which point it will be 
transferred to their Inbox. 

 

Importing Incoming Data: 
 

After synchronising, if you have received any publications (for example Cropping from one 

or more of your clients), you will see a ‘New Messages’ balloon pop up in the bottom right 

of your screen. You can “preview” the contents by clicking the “view file” button. 

 

To import the data: 

1. Go into the Publishing module and click on the ‘Inbox’ tab. 
 

2. Highlight the data you wish to import and click “Import Published Data”.  
 

3. In the ‘Field Data Import Options’ window, select the relevant options and click 
“Import Data”. At the warning message, click Yes. NB. You can delete any 
publication(s) from your Inbox or Outbox by highlighting it and clicking Delete Item.  

 

Transferring data to and from a non-Gatekeeper user: 
 

You can use the Publishing module to transfer data to and from a non-Gatekeeper user. For 

example your client might be using a Gatekeeper compatible software package.  In these 

circumstances, you might want to transfer any of the following types of data: 

 

Cropping set-up details – when you and your client transfer data it is essential that 

your fields and cropping are set-up identically. You can ensure this by exporting your 

cropping set-up from Gatekeeper to the other package. In that way you should get 

recommendations coming back that will merge with your data successfully. 

 

Data is transferred to and from third parties using the Third Party tab in the 

Publishing module. There are two options for Third Party Data Exchange which are: 
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Import Field data – use to import cropping from your client (it is better if the grower 

exports their cropping to the agronomist usually) 

 

Export Field Data – use to export cropping and/or operations to a third party. 
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Orders Module 
 

Having created a recommendation for a client, you may also want to create an order for the 

products required, which can be emailed directly to the product suppliers or printed out and 

faxed. The order consists of an itemised report including products, quantities, and also 

optional product information such as prices, active ingredients, pack sizes etc. The order 

includes the purchaser and supplier contact details together with delivery point comments if 

they exist.   

 

Orders can either be built from scratch, or based on an issued recommendation (a Plan-

based Order). The Plan Based Order method is the quickest way to build an order assuming 

that it is to be based on one or more recommendations that have already been created and 

issued.  

 

Creating a Plan-based Order 
 

Creating an Plan-based Order direct for an issued plan: 

A plan-based order can be created at the point of issuing a recommendation. After clicking 

the Issue Plan button (see page 24 for more information on creating and issuing 

recommendations), click the Order Requirements button (see image) and follow on from 

step 4 in Creating an Plan-based Order from Scratch section below . 

 

 

Creating an Plan-based Order from Scratch: 

1. In the Orders main module window, click Add Order (the first module option). 
 

2. In the ‘Add New Transaction’ window, enter a ‘Reference’ as appropriate and select 
the ‘Plan based order’ radial button. You can choose to turn the pack option On if 
you want Gatekeeper to calculate requirements based on optimised packs (this 
assumes you have setup pack sizes). Click OK. 

 

3. In the ‘Plan Selector’ window, select the recommendation(s) you wish to use to base 
the order on 
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4. NB: You can filter the Recommendations included in the list by using the Today, This 
Week and All filter options. Click OK to continue.  

 

 

 

 

 

 

 

 

5. Gatekeeper will create a grid of product requirements based on the 
recommendation(s) selected (see previous page).  The Recommendation amount can 
be overwritten using the ‘Override To Buy’ column). If the ‘Detailed columns’ box is 
ticked (see previous page), a ‘Checked stock’ column will appear in the grid. Enter 
the on-farm quantity of product the client already has and this amount will be 
automatically deducted from the ‘To Buy’ column.  

 

6. Also within this window you decide which supplier, or ‘Company’, you wish to buy 
the products from. You may want to select the supplier companies manually in 
which case choose the supplier for each product by double-clicking in the ‘Company’ 
column. To choose the same company to supply all products, click Pick Company for 
All. 

 

Alternatively you can choose the appropriate Fulfilment Method and then click the 

Recalculate Best Buy Companies button which will use the selected fulfilment method 

to populate the supplier grid. 

 

Fulfilment Methods: 

 Job target price (lowest) – Uses the price of the product in the Jobs in the source 
Plan/s. Use this if you have priced products “on the fly” when creating jobs and 
want to use those rather than Catalogue prices. Note: if a product appears in 
more than one job in the source Plan/s at a different price, then the lowest price 
will be used. 
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 Cheapest unit price, no pack breakdown – Uses the cheapest unit price 
regardless of pack size and does not show any pack price breakdown. 

 Cheapest unit price, pack breakdown – Uses the cheapest unit price regardless 
of pack size, but does show the pack breakdown. 

 Cheapest total value pack combination - Calculates the best combination of 
packs giving the cheapest total value for each product in the Requirements grid 

 

NB: You can setup Companies by clicking Pick Company ► Setup Company ► Add. 
Remember: if you wish to email them you need to set up the supplier as a Contact as 
well (see step 3, page 10.). If you wish to set one company as your default supplier, 
click in the Business/Year selector ► Edit Business Details ► tick the box within the ‘Fixed 

company for orders and catalogue prices’ area and choose the company. 

 
7. Click Build Orders and your chosen products will be listed in the ‘Orders Setup’ 

window. You can adjust any details as required, including adding more products 
using the Select Products button (for example to add tank cleaner etc) 

 

8. If visible, click the Issue Order button (ringed in yellow) and your order status will 
turn from a ‘Draft Order’ to an ‘Issued Order’. Click OK. 

 

NB. If the issue Order button is not visible, the 'Automatically issue generated orders' 

option was ticked (circled red at the bottom of image on previous page). Click OK 

and move on to step 8. 

 

9. To print out, email or export the order, highlight it in the main tree view and click 
Reports (fourth module option). Select Order in the ‘Select Report’ window and then 
choose to include prices and/or active ingredients in the order, if required. Click Run 

Report. Within the preview report window, you can email (using the  button), 
print out or save the order.    

Creating an Order from Scratch 

1. Click Add Order (the first module option). 
 

2. In the ‘Add New Transaction’ window, enter a ‘Reference’ as appropriate and select 
the ‘Order’ radial button. You can choose to turn the pack option on if required. Click 
OK. 

 

3. In the ‘Select Supplier’ window, choose the ‘Company’ you wish to buy the products 
from.  You can setup Companies by clicking Setup Company ► Add. Remember: if 
you wish to email them you need to set up the supplier as a Contact as well (see step 
3, page 10.). 
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4. You build your order by selecting products within the ‘Product Selector’ window and 
filling in the quantity column in the grid. Click OK. 

 

5. Edit the order as required in the ‘Orders Setup’ window, then click Issue Order 
(ringed in yellow) which turns the ‘Draft Order’ into an ‘Issued Order’. Click OK. 

 

6. To print out, email or export the order, see step 8 above. 
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Fields Module 
 
This module is for browsing your field records with options for searching and filtering the data: 

 

 

 use the Filter Buttons above the tree view, 

 type in the beginning of a field name in the search facility above the tree view, 

 use the Grid Tabs to change details in the Main Grid, 

 sort the data in the Main Grid according to column heading (the illustration shows 
the data sorted by date – indicated by the grey arrow at the top of the ‘Date’ 
column), 

 click Filter (top right) to adjust what is contained in the Main Grid – this allows you 
to filter field records to show your recommendations and/or a client’s imported field 

records (indicated by ); and also the status of the records (e.g.  indicates an 
issued recommendation, neither started nor completed), 

 click Show Details to view more details about the highlighted field record.  
 

If you need to edit any details in the Main Grid, such as recording a different quantity of 

product applied, just click on the operation and double click on the cell containing the data 

to be edited. This will take you to the original Job Record, which can be edited (e.g. allowing 

you to change all fields or individual fields if in complex proportion mode, within the job, if 

required).  
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Setting up Fields and Cropping 
 

Use this to setup and manage annual cropping records. The Setup Fields button (first 

Module Option) will take you to the ‘Setup Fields’ window. NB: Once you have existing fields 

within Gatekeeper, clicking Setup Fields will take you to the ‘Cropping Summary’ window. If 

you need to edit any field details, such as splitting a field or adding Buffer Zone information, 

double click in the year column within the field you require and you will be taken to the 

original field data. 

 

1. Overtype ‘New Field’ with the name of your field and fill in your field details. 
2. Click Cropping Record.  
3. NB. If you want to split a field, click Divide Field (bottom middle of the ‘Setup Fields’ window) ► Add 

Item ► Fill in the ‘Working Area’ of the first part of the field ► Add Item and repeat the process until 
you have the right number of splits to your field ►OK. 

4. You should allocate a crop to the field (middle section of ‘Setup Fields’ window). If you haven’t got any 
crops or varieties already set up, or you have new crops for the season, click Setup Crops and 
Varieties and work through the setup process. Having completed this, return to the ‘Crop’ drop-down list 

and choose the cropping for your field.  

 

Managing Cropping Year 
 

When you want to set up a new Cropping Season or convert a future Cropping Season 

(purple Plan Year) into the current Cropping Season (green Current Year):  

1. Click the coloured box (probably green) with your business name in it (top right 
corner of main Gatekeeper window), which takes you to the ‘Main Business and Year 
Selector’ window. 

2. Click Manage Cropping Year. 
3. Click Advance (which will convert your Plan Year into your Current Year and your old 

Current Year into a yellow Previous Year). Click Yes at the warning. 
You can allocate cropping to the new Cropping Season using the following instructions. 

 

Starting a New Cropping Season  
 

In Gatekeeper, you can allocate cropping to a new season at any time, even for Plan (purple) 

Years, from the ‘Cropping Summary’ window. This process allows you to copy all or part 

cropping from a previous season to the new season. This does not necessarily have to be the 

immediately preceding crop year. If you have the Farm Mapping module enabled, you will 

also be managing the field region boundaries (see separate Farm Mapping Quick Start 

guide). 
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1. Click Setup Fields button (First module option).  
2. Within the ‘Cropping Summary’ window, click anywhere in the column for the year in 

which you want to allocate cropping and the Setup Fields for 20?? button (bottom 
centre) will change colour to reflect the year you have chosen. Click this button OR 
double click the cell in the new year column adjacent to the field for which you want 
to set up the cropping. 

 

3. The ‘Add Field to Cropping Year 20??' window will appear (see over). Choose from 
one of the following four options - 
 

a) To copy all fields exactly as they are in a previous year: 
I. Use the 'Source field from' dropdown box at the top of the window 

(above the tree view) to select the cropping year you wish to copy all 
fields from. 

II. Click the Copy ALL Unused Fields From Source Year button. 
 

b) If you want to copy the main field only (without splits) and allocate new 
cropping: 

I. Use the 'Source field from' dropdown box at the top of the window 
(above the tree view) to select the cropping year you wish to copy the 
field from.  

II. Click the field name within the tree view on the left so it’s highlighted  
and click Copy Source Field button. 

 

c) If you want to copy the field and ALL of its splits together with allocated crop and 
variety (you can change the crop and variety in one or more splits later if 
necessary): 

I. Use the 'Source field from' dropdown box at the top of the window 
(above the tree view) to select the cropping year you wish to copy the 
field from.  

II. Click the field name within the tree view on the left so it’s highlighted and 
click Copy Source Field With Cropping button. 

 

d) If you want to copy some but not all of a previous years cropping for a field:- 
I. Use the 'Source field from' dropdown box at the top of the window 

(above the tree view) to select the cropping year you wish to copy the 
field from.  

II. Click the field name within the tree view on the left so it’s highlighted. 
III. Click the cropping record(s) within the 'Copy selected field Parts' box on 

the right so they are highlighted, and click Copy Selected Source Parts 
with cropping button. 
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e) If you want to add a completely new field never before used in Gatekeeper, click 
the Add New Field button at the bottom.  

 

 

4. A new cropping record will be created to which you should allocate the appropriate 
crop and variety if necessary.  

 

5. Click Next Field button (bottom right corner) to display the ‘Add Field To Cropping 
Year 20??’ window again. You will see that the field list reduces as the cropping is 
allocated. 

 

NB: To allocate the same crop and variety to the next field as the previous one, 

select it and click Copy Source Field. A new cropping record for the field will be 

created using the same cropping allocated to the previous field.  

 

If you are not cropping a particular field in this season do not create a cropping record for it 

in the new year. It will be available in subsequent years if required, but will not appear in 

the new year field list unless you subsequently create a cropping record for it in that year. 
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IMPORTANT: 

Remember to click Save as you go. DON'T CLICK Cancel unless you want to lose all changes 

since your last save. If you do make a mistake, click Save and then edit the field to correct 

the error. 

The ‘Cropping Summary’ window 

In this window you can review the cropping for the current year and previous/following 

years. You can also (for example) amend cropping, split a field or add Buffer Zone 

information in any year by first clicking any cell in the column for the crop year in which you 

want to work. You will notice that the button in the centre will change colour to match the 

chosen year and the button text will include the year name. Click this button to open the 

‘Setup Fields’ window and amend any field details as required. 

Reporting on fields. 

In each Gatekeeper module there are a range of reports specifically relating to that module 

and the Fields Module is no exception. From the Fields main module window select a field in 

the tree view on which you wish to report. Now click the Reports module option button. 

Choose the appropriate report e.g. Field Gross Margin and then click Run Report. 

Depending on the specific report that you choose, there may be some options to select 

before running the report. You can run a field report for the single selected field or for a 

range of fields. 
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Nutrient Management  
This module option allows you to plan your Nutrient Management strategy and create 

Nutrient Management Plans using your Gatekeeper data in conjunction with the PLANET 

RB209 software engine. The Nutrient Management module is valid for both England/Wales 

and Scottish regions. But there are a few things you need to check first:  

 
 It’s important to check that your fertilisers and organic manures have been setup 

correctly and that their nutrient analysis has been recorded: Setup (in the top 
menus) ► Products (business)► in the tree view of the ‘Setup Products’ window 
choose Variable costs ► Nutrition ► Fertiliser look through your fertiliser products 
and fill in the nutrient analysis (bottom right box). Repeat this process for Organic 
manures. Organic manure type products can be linked to their Planet type 
equivalent. Click on the 'Planet' tab and  use the appropriate button for your region.    

 

 You need to enter your Telephone Area code so that PLANET can get the standard 
rainfall figures for your area of the country: Setup ► Holdings ► fill in the area code 
of your telephone number, i.e. 01986 

 

 If you are in Scotland, you must select one of the Scottish type Yield Regions in Setup 
Holdings otherwise it will assume your business is in England. If you have farms in 
both Scotland and England you should create separate holdings for each and make 
sure that the fields are linked to the appropriate Holding. 

 

To run a Nutrient Plan: 
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1. Click Nutrient Management (second module option) and the 'Nutrient Management 
Centre' will appear. Choose the field(s) that you want to include in the Nutrient Plan 
by selecting them in the tree view. 

2. Click the Edit Nutrient Management Plan button and the 'Nutrient Management 
Plan Update' window will appear. With the default selection of 'Update nutrient 
requirement using PLANET RB209' picked, click the Update button (Bottom right 
hand corner). For more information on the other options within the window, see 
imbedded help.  

 

3. The ‘Sampling Heading Selector’ window will appear. Select the nutrients that you 
wish to include in the Nutrient Plan and click OK.  

4. NB: If running Nutrient management for the first time, you must select all nutrients. 
This is because some nutrient management reports include all nutrients and cannot 
except a null value. Click the double arrow to transfer all items across to the right 
hand side. Click OK.   

 

5. The ‘Nutrient Management’ window will then appear with recommendations for 
each field. 

  

 

NB: Certain information is required for the nutrient calculation. If any of these details are 

missing the field/s will be marked with a red cross. Required data fields can be found by 

clicking the ‘Field’ and ‘Soil’ categories in the tree view and are marked with an asterisk. In 

addition the ‘SNS’ (Soil Nitrogen Supply) is calculated on previous cropping by default. If 

there is no previous cropping information, you will either need to add it, or manually add a 

measured SNS figure before the nutrient requirement can be calculated. 
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6. Click OK to return to the 'Nutrient Management Centre'.  You will now have a fully 
populated Nutrient Management Plan, Nutrient Audit and Nmax Audit. The 
screenshot shows the NMax Audit tab.  
NB: For the Nmax Audit to work, fields need to be set as 'in NVZ'. This can found on 

the main field setup. (See imbedded help on field details for further information).   
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Building a Nutrient Job directly from Nutrient Plan: 
 

1. Once the nutrient plan has been run (follow steps for 'To run a Nutrient Plan' on 
previous page), click the Jobs button at the top of the 'Nutrient Management Centre' 
window. 

 

2. If not already displayed in the treeview, click Select Fields button (directly beneath 
tree view) and pick the fields intended for the job. 

 

3. Within the 'Prepare Jobs section' (see image over), choose the options to decide how 
you wish to prepare the job and click the Prepare Jobs button to build. 

 

4. With a Job now prepared (see image over), under the 'Add Jobs To Plan' section, 
choose which type of plan to add the prepared job(s) too. Use the 'New plan 
reference' box to name the plan. Click the Add Jobs To Plan button to add.  

5. Click OK to save and exit or to convert a Nutrient recommendation to a product 
based recommendation see step two of the 'To convert a Nutrient recommendation 
to a product based recommendation' on page 30. 
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Recording Module 
 

You can add new field records (NOT Recommendations) to Gatekeeper via the Recording 

module. Use the Recording module if you want to add new records for operations that have 

already been carried out and for which you did not create a Recommendation. 

 

All of this type of data is job based. A Job is defined as one or more fields treated with the 

same product/s and rate/s (although rates can be changed across fields within a job using 

the Complex Proportion and Share Used methods – see later notes). The advantage of using 

a Job structure is that the Job in its entirety can be recalled later if it needs editing instead of 

having to find and edit individual field records (for example to correct an inputting mistake). 

 

There are various Job types: 

 Field Operations – The most commonly used job type, used to add products and 
machinery records to fields and also record harvest type operations. 

 Field Operations Express – Only used when there is a backlog of historical records to 
add to individual fields (can be several fields). For example for new users starting 
part way through a season. 

 Field Operations Machinery Only – Only used to add machinery records with no 
associated product. 

 Field Operations Products Only – Only used to add products without any associated 
machinery record. 

 Field Sampling – Used to add soil sampling results to fields. 

 Field Nutrients – Used to build a job based on nutrient required rather than fertiliser 
product. These jobs can then be converted into product based jobs. 

 Field Diary Notes – Used to add diary notes rather than products to fields. (Notes 
can also be added at the same time as making an Operations type job also) 

 

Completed jobs are shown in the tree view of the main window, listed by date of recording. 

By highlighting a date, the associated job details are displayed on the right 

Adding a Job 
 

For new users starting part way through a season needing to enter a backlog of data to each 
field, otherwise go to next section: 

1. Click Add Job (first module option). 
 

2. In the ‘Add New Job’ window, choose ‘Field Operations Express’ from the drop-down 
list on the right and click Add Field Operations Express Job (middle). 
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3. In the ‘Field Selector’ window, select the first field (or selection of fields as long they 
have had the same treatments e.g. all rape fields) that needs to be updated. Click 
OK. 

 

 

4. In the ‘Product Selector’ window, select the product(s) you wish to add to the field, 
starting with the first operation (e.g. ploughing). Remember you can type in the first 
few letters of the product’s name in the search box above the tree view to save 
scrolling through the whole tree view list.  

 

5. Enter the date and rate, or quantity, for the product and then select the next 
product (e.g. power harrow). Repeat this process for all operations and products 
applied to the field up to the current date. 

 

6. Click OK and Gatekeeper will create the jobs that you have just entered within the 
‘Recording Setup’ window. Check the data is correct and then click OK to save the 
data and return to the main Recording window. 

 

7. Repeat the process for each field (or group of fields), until all your field records are 
up-to-date.  

 

For users who wish to add records to individual, or groups of, fields: 

1. Click Add Job (first module option). 
 

2. In the ‘Add New Job’ window, choose ‘Field Operations’ from the drop-down list and 
click Add Field Operations Job.  

 

N.B: You can add other records apart from Field Operations - Field Diary Notes or 

Field Sampling; choose either option from the ‘Add New Job’ window drop-down 

lists.  

 

3. Select the field(s) you wish to add records to in the ‘Field Selector’ window. 
 

4. Select the product(s) you wish to record to the selected field(s) – e.g. If you are 
fertiliser spreading, you would add the appropriate operation from within Fixed 
Costs (e.g. “Fert Spread”) and the appropriate fertiliser from within Variable Costs; If 
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you were combining cereals, you would add ‘Combine’ from within Fixed Costs and 
the output product from within Outputs. Once selected, click OK. 

 

5. Fill in the yellow cells in 
the ‘Recording Setup’ 
window (see above) as 
required. Double 
clicking on some cells 
will cause a drop-down 
list of options to appear 
(weather conditions 
etc). If you have several 
fields within a job, you 
can tick the ‘Block job 
together as a group’ 
box (middle centre) and 
the start / finish dates 
will be universal.  Below the fields grid there is an “Add Work Records” button. This 
is a quick and easy way of adding times and dates to the fields. See the detailed help 
for further information on this option. 

 

6. You can add more information to the job by using the tabs at the bottom of the 
window, e.g. the ‘Job Header’ tab allows you to record your reasons for doing the 
job or other comments that will show up on any field traceability report. Similar 
options are available to add product and field comments.  

 

7. Click Save, then OK when you are finished. 
 

NB: If you wish to repeat a job, choose the job type and then the ‘Copying from the selected 

job’ option in the ‘Add New Job’ window and highlight the job to be copied in the tree view. 

Click Copy Field Operations Job (or Copy Plan if you are in the Planning Module). 

 
You can edit any job at a later date by using the Edit Job module option. 

 

Complex and Share Used proportioning methods 
 

In a recording Job the total product quantity is normally apportioned to each field on the 

basis of the field area to which the products were applied. However, there are two other 

proportioning methods which can be used giving great flexibility. 
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Unless otherwise specified products will always be apportioned on the basis of area. To use 

either Share used or Complex methods, first create the Job as normal selecting the Job type, 

fields and products. In the Recording Setup window click the Job Header tab and then the 

Proportion Method tab. Choose the appropriate method. 

 
 
 
 
 
 
 
 
Share Used – Use this method if you 

have changed calibration part way 

through a job between fields and have 

therefore used different application rates on fields within the same job. You can enter the 

approximate amount of material (or mix in the case of a spray operation) against each field 

and the actual total amount of each product used. The product will be proportioned on the 

basis of the Share used figure rather than the application area. This is useful when fertiliser 

spreading for example and the first field applied is over the target rate. Make a note of the 

approximate amount of material used on that field (which will later be entered in the Share 

Used box) and then adjust the fertiliser spreader calibration before applying the next field. 

At the end of each field make a note of the approximate amount used on each field. When 

the Job is completed record the actual amount of total material used. When you  

come to enter these details in the Job, set the proportion method to Share Used and then 

click the Job tab where you will see a new column labelled Share Used. Enter the share used 

amount for EVERY FIELD in the Job and the total amount of product used in the Total 

Quantity box. 

 

Complex product allocation – Use this method when you know the absolute amount of 

each product applied to each field in the job and that amount is NOT to be proportioned on 

the basis of area. When you set the proportion method to Complex product allocation a 

new tab will appear at the bottom labelled Complex. First record the start/finish and any 

other details against each field in the Job tab and then click the Complex tab. In the grid in 

the Complex tab you can edit the Quantity applied for each product against each field. As 

you do this Gatekeeper will re-sum the total applied in the Job tab for each product.  You 

can also change the completed area and Wastage of each product against each field. 
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Splitting Jobs 
In the Job tab there is a button labelled Split Job. This gives great flexibility when setting up 

and saving Jobs in either Recording or Recommendations because it allows you to create a 

Job with all of the details including fields, products, comments etc, but then split out one or 

more fields moving them into a new job containing all of the same details as the “parent 

job” then you can tweak the products/rates on the split out job. See image below for three 

options available. 
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Analysis Module 
 

This module creates reports from summarised data from within Gatekeeper. Report themes 

include Cropping, Diary Notes, Fertiliser Field Operations, Soil Sampling, Stock and Trading. 

Also Syngenta Partnership Plan output reports are available on request. You can copy any 

pre-defined report and then change any aspect of it adjusting it to your specific 

requirements. They can be viewed on-screen, printed, or exported in XML format which can 

be opened in most spreadsheets. 

 

Running an Analysis Report 
 

1. Select any pre-defined report from within the tree view of the Analysis module. If 
this is the first time you have opened a report in that section during this session, you 
will be taken to the ‘Refresh Analysis Summary Data’ window (see below). You only 
need to refresh data if there have been changes to the data since you last used this 
section.  

 
 

2. Select as many years as you need to be refreshed and click Refresh Data. Note: If 
you change data elsewhere in Gatekeeper it will NOT be reflected in the Analysis 
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Module until you run the Update process. Once the refreshing process is complete, 
click Close. 

 

3. Either click OK to run the report with the default filters (see over) or you can choose 
your own filters by ticking the ‘Select all’ box or clicking the Pick button for each 
heading and choose what you want to be included in the report. Ticking the boxes 
within the ‘Transaction Date’ area will allow you to specify the start and end date 
boundaries for the report. Once you have made all your selections you will be able to 
click OK and the report will be displayed in the main Analysis window.  

 

4. If you want to make changes to the report by changing your filter choices, click Filter 
(third module option) and you will be taken back to the ‘Analysis Filters’ window. 

 

 

 

Creating a Personalised Report 
 

You can copy a pre-defined report and then change it to suit your requirements. You can 

then save this report for future use. 
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1. Click Setup (sixth module option) and highlight the pre-defined report you wish to 
copy from the drop-down lists and 
tree view (see right). Click Copy 
(bottom left) and the ‘Copy of…’ will 
be listed in the tree view. You can 
rename it as you wish by clicking in 
the ‘Name’ box. Then click OK. 

 

2. Choose your filters from the ‘Analysis 
Filters’ window. Click OK. 

 

 

 

 

3. Once the report is shown in the main Analysis window, click Options (first module 
option) and then the ‘Options’ tab. Tick and/or untick boxes from the ‘Visible’ 
column to make up your report. Click OK and pass through the ‘Analysis Filters’ 
window again. Click OK, and your new report is shown in the main window.  

 

To print out a report, click Print (Seventh module option) or to export the report as XML 

(which can be imported into most modern spreadsheet packages) click Export (third module 

option). 

 

Creating a Chart for a Personalised Report 

 
You can create a graphical representation of your personalised report using a variety of 

Chart styles. This can be displayed on screen and printed out. 

 

1. Copy a pre-defined report as per steps 1-3 on the previous page. 
 

2. Once the report is how you require it, click on the Options drop down arrow and 

select Chart Settings.  
 

3. On the Analysis Options screen, tick the box to ‘Include a graphical representation 
(chart) of the grid data’. Select the headings to be displayed in the X and Y Axis 
Columns. Click OK. 
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4. The chart will be displayed on the screen. The Chart and Grid can be hidden from 
view by clicking the Hide buttons at the bottom of the screen. 

 

5. To edit the Chart, click on the Options drop down list and select Chart Settings or 
Styles as appropriate. The Chart can be printed/published with or without the Grid. 
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Synchronise Module 
 
It’s essential to synchronise regularly - preferably at the end of each working session when 

changes have been made to the data. During synchronisation, your data will be backed-up, 

any updates for Gatekeeper or Sentinel will be downloaded and applied, and publications 

will be sent and/or received.  

 

When you synchronise 

Gatekeeper, a data backup will 

be created automatically. The 

backup file will be placed in a 

default location or in a user 

defined location.  Gatekeeper 

will keep the last three backups 

in any one location, 

automatically replacing the 

oldest one when necessary.  

Gatekeeper “Data Secure” users 

will also have a secure data 

backup on the Gatekeeper remote servers which will be updated at each synchronisation. 

 

For Data Local users  
 

You can either back-up to the default location (on your hard drive) or chose an alternative 

location wherever you like. Once you have designated an alternative location, each time you 

synchronise the back-up will be placed there, unless you change it again. The last three 

backups are maintained in any one location with the oldest one being overwritten on the 

fourth backup. Clicking Synchronise will begin the process and any downloads will be 

collected from the Gatekeeper server. When synchronisation has finished, click Close and 

Gatekeeper will self update and require you to log on again to re-enter the program, or exit.  

 

For Data Secure Users 
 

During the synchronisation process, your data will be securely backed-up to the Gatekeeper server and your 

previous data on the server will be overwritten. In addition a local copy of your data will be made on the hard disc 

of your computer. You can either back-up to the default location (on your hard drive) or chose an alternative 

location wherever you like. Once you have designated an alternative location, each time you synchronise the 
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back-up will be placed there, unless you change it again. The last three backups are maintained in any one 

location with the oldest one being overwritten on the fourth backup. 

 

Clicking Synchronise will begin the process and any downloads will be collected from the 

Gatekeeper server. When synchronisation has finished, click Close and Gatekeeper will self 

update and require you to log on again to re-enter the program, or exit. 
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Sentinel Module  
 

When you run Gatekeeper the Sentinel module is loaded automatically. If you want to 

access any of the other modules, just click the appropriate module button. You don’t have 

to close Sentinel first. 

 

The Sentinel module gives you access to a wealth of agronomic information including 

pesticides and pesticide labels, best practice details provided by manufacturers in the 

Technical updates section, Nutritional and fertiliser information in the Fertilisers section, 

Variety recommended lists in the Seeds and Varieties section and much more. 

 

Every time you synchronise, Sentinel checks for updates making sure that all information is 

current. 

 

 

Sentinel Verification 
 

All copies of Gatekeeper are capable of verifying Recommendation or Recording Jobs. 

However, only users who have subscribed to the optional SentinelActive module (Currently 

UK only) will have their recommendations verified against UK crop approvals for supported 

pesticide types (Herbicides, Insecticides, Fungicides, Growth Regulators, Molluscicides). 
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On Sites not subscribing to SentinelActive, verification will be against any user-defined 

checks added to either the Site or Organisation catalogues, user-defined protocols and if the 

Nutrient Management module has been used, fertiliser jobs will be verified against the 

calculated required nutrient less that already applied (plus issued recommendations). Jobs 

will be checked against calculated individual field NMax totals also. 

 

Users should note that the final responsibility for the integrity and correctness of their 

recommendations lies with them.  

 


